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Introduction

z}})ll

/,,, ,l‘ This training material is part of the FME Training Pathway system.

o
I,,

-

Introductory Movie

Database Pathway
This training material is part of the
FME Training Database Pathway.

FME Desktop Tutorial

The Smallworld training pathway O
contains advanced content and K ‘[ _l \!
assumes that the user is familiar with -

all of the concepts and practices [ e ] [R”T] [] [”" ']
covered by the FME Database l

Pathway Tutorial, and the FME
Desktop Basic Training Course.

y A A

FME Desktop Basic Training

A A A
FME Vel'Slon Dﬁ‘“"fr;enﬁ':;“”“’ I Raster Pathway Training ESRI Pathway Training KML Pathway Training
This training material is designed [ ] I ] [ ]
specifically for use with FME2015.1. v v v
You may not have some of the
functionality described if you use an
older version of FME.

Continuing Professional Development
(Webinars, ons, C erc)

Sample Data
The sample data required to carry out the examples and exercises in this document can be
obtained from the training resource page:

e Full FME Training Dataset
EME for Smallworld Training Data

Smallworld Database

This training includes documented steps for GE Smallworld Core version 4.3 using the

FME Translator 4.3. This training uses the Smallworld Cambridge sample database as well as
some secondary dataset, see links above.

Older versions of Smallworld or the FME Translator do not support the functionality described in
this training. Other Smallworld varieties will differ in their use.

This training assumes the user is familiar with the Smallworld applications for inspecting the
Smallworld database and managing ‘alternatives’.

Introduction Page 4


http://www.safe.com/fmedata
http://www.safe.com/learning/training/resource-center/smallworld/

Smallworld 4.3 Training Pathway

SAFE SOFTWARE

Training Course Resources

The data used in this training is largely based on data from the Smallworld Cambridge Database
supplied as part of the Smallworld core product. The Cambridge database is installed on your

Amazon AWS computer.

See the section: “Starting the Smallworld GIS” on how to start the Smallworld GIS.

Other resources you will be working with are:

Location

Resource

C:\FMEData2015\Resources\Smallworld

Datasets used by this training

C:\FMEData2015\Workspaces\SmallworldTraining

Workspaces used in the exercises

C:\FMEData2015\Output

Good place to direct any exercise output

<documents>/My FME Workspaces

Default location to save FME workspaces

Introduction
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Working with the Smallworld Database and FME

The Smallworld FME translator provides access to Smallworld
objects in a form suited to most GIS and CAD applications.

The Smallworld database provides a rich set of functions and capabilities for managing GIS data.
Smallworld uses the VMDS database for its data storage. That database structure often needs to
be translated into other formats suited to other GIS and CAD applications.

Smallworld objects typically contain multiple geometries, whereas many other GIS formats have
limitations on their support for multiple geometries. FME provides a powerful toolkit to translate
between Smallworld objects, including multiple geometries, and other GIS formats.

Installation

FME Smallworld Suite consists of several components;
¢ FME for Smallworld Edition - FME with Smallworld licensing
e Smallworld Translators Suite DVD which contains:
o Install documentation (swtransins.pdf) and installer
o Smallworld Translators Suite User Documentation
o Smallworld FME Translator magik
o FME dll and FME metafile

Both the Smallworld 4 core and the Smallworld FME Translator must be installed in order for FME
to be able to read or write Smallworld data.

The installation components are supplied by GE Smallworld on the Smallworld Translators Suite
DVD. Ensure you have the installation pack that matches you're version of Smallworld core
product.

Starting the Smallworld GIS
Before you start the FME for Smallworld training, you need to start-up the Smallworld GIS. Here’s
what you need to do:
1. Onyour Amazon AWS Remote Desktop — double click or Open the Start Smallworld
shortcut icon. Two events will happen:
a. The emacs editor will start and open at a MagikSF> command prompt
b. The Smallworld Application Manager will open

Working with the Smallworld Database and FME Page 6
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@emacs@NDNA [
File Edit Options Buffers Tools SW Gis Help

DEExBHE I $EEREXT A f & b s

H#HE® E
# b “satch®
|Z|; Thiz buffer is for notes you don't want to save, and for Lisp evaluation. -
H u want to create a file, wvisgit that file with C-x C-f,
:; then enter the text in that file's own buffer.
@ Smallworld Application Manager l = | e
Application Status =
'Egj Administration - Smallword Core Available
3] Case Tool Available
'ﬁa‘ Corffiguration - Smallword Core Available
[3] FME Import & Expott Available
3] Professional - Smallworld Core Available
-1%--- #scratch¥ 211 L1 (Lisp —
Favl Fais
i -~
Customisation Froducts:
user custom 4.3.0 Produc i
5w_cEre_help 4.3.0 Help 1
Help Log Off

Database (2) Re-Opened Successfully
False "C:\Smallworld43\cambridge db\images\fme43.msf"

MagikSF> '
MagikSF>

m

—1\*¥_ kgisk Bot L34 (Gis: run AC Abbrewv)
Filtering Magik ocutput...(ll chars) -

Start the Smallworld Connection Service. This service allows the FME ‘client’ to connect
to the Smallworld VMDS database ‘server’. In emacs, at the MagikSF> prompt enter:

MagikSF> fme connection_service.start (30000, _unset, :gis)
You should see the response:

fme_connection_service running_on_port: 30000

a sw:fme_connection_service

MagikSF>

Note: For Smallworld 4.3.0.7 you may see the response:
FME Import & Export has started an fme tics server on port 30000
a sw:fme_connection_service
MagikSF>

In the Smallworld Application Manager, select the Professional — Smallworld Core
application and click Start.
Do not select the FME Import & Export application - this is the older FME interface

In the Smallworld GIS, select the Bookmark tool (or use View — Bookmarks) and select

the Electric Network bookmark. This will zoom

into the area of interest for the training. = o R e &
“f &

Open the Version Manager and then select the
correct dataset.
a. Inthe Smallworld GIS, select File —
Versions...

level-crossing

Milton

Morth Westem Europe

slips

Smallword ™

Working with the Smallworld Database and FME Page 7



Smallworld 4.3 Training Pathway

SAFE SOFTWARE

6. Select Dataset: Electricity
VRN R esH DR
Dataset: | Cument Atemative

=) ~top™
+{[5) FME You’'ll come back to the alternatives and versions later in the
=+ [ fme_training training.

+ ) fme_updates

Import/Export Errors

If an import/export error occurs, check the FME log first. The traceback messages in Smallworld
will generally be misleading. If you can’t determine the problem cause in the FME log, next check
the emacs traceback to see whether the error occurred in the Smallworld FME translator. The
document “Smallworld Translators Suite, Smallworld FME® Reference” from GE does describe
some of the typical Smallworld errors which may occur.

If an error occurs during an import to Smallworld it is probably wise to rollback to a checkpoint to
ensure that invalid data was not loaded.

SpatialBiz Plug-in Interface Between Smallworld and FME

The SpatialBiz Plug-in for FME from Spatial Business Systems Inc provides another interface
between FME and Smallworld, separate from the Smallworld FME Translator. The SpatialBiz
Plug-in may offer advantages over the Smallworld FME Translator in certain circumstances

More information about the SpatialBiz Plug-in for FME is available on EME Knowledge Center.

This course does not cover the use of the SpatialBiz Smallworld reader/writer plug-in for FME.

Working with the Smallworld Database and FME Page 8


https://knowledge.safe.com/articles/FAQ/FME-Smallworld-configuration-options

Smallworld 4.3 Training Pathway

SAFE SOFTWARE

Getting Going

Setup the coordinate system used by the examples and test the
connection service between FME and Smallworld

Coordinate Systems

Smallworld generally uses a worldwide coordinate system. The coordinate units are usually in
inches, cm or mm, depending on the coordinate resolution required. When translating to other
formats, this world coordinate system will most often need to be reprojected into a different
coordinate system. FME may not support the coordinate system in the units of the Smallworld
world coordinate system. For example, FME supports the British National Grid coordinate system
in meters. But the Cambridge database use a British National Grid millimeter coordinate system.
So we have created a coordinate system called BritishNatGrid_mm for the FME Smallworld
training.

You may wish to create a custom coordinate system to support the units your Smallworld is using
refer see the FME User Documentation: FME Coordinate Systems .

Setup: Install Coordinate System

Objective Install coordinate system used by Cambridge sample database

Install a Coordinate System
The Cambridge sample database uses a millimeter coordinate system, BritishNatGrid_mm that is
not included in the FME installation.

Install this coordinate system in preparation for the examples to follow.

1) Install BritishNatGrid_mm

Locate this coordinate system file in the Smallworld training resources folder at
C:\FMEData2015\Resources\Smallworld\Coordinate Systems\
BritishNatGrid_mm.fme

Have a quick look at the BritishNatGrid_mm.fme file using NotePad or other text editor.

Copy the BritishNatGrid_mm.fme file, then paste it at
<My Documents\FME\Coordinate Systems\BritishNatGrid_mm.fme

If it is not already present.

Restart FME Workbench and FME Data Inspector so they will load this new coordinate system.

Getting Going Page 9
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FME does not know which coordinate system a Smallworld database is using.

You must determine which coordinate system Smallworld is using and be sure to
specify that coordinate system explicitly for each FME reader and writer that is
connected to Smallworld.

-

FME might not contain a world coordinate system that matches your Smallworld
database.

~

In that case, you may have to create a custom FME coordinate system to match
your Smallworld database. See the FME User Documentation: FME Coordinate
Systems > Custom Coordinate Systems > About Custom Coordinate Systems

\_ J
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Connecting to the Smallworld Database

The Smallworld VMDS database must have a connection service configured so that FME can
communicate with the database and read or write objects.

FME Connection Service
Before FME can connect to the Smallworld VMDS the FME Connection Service must be running
on the Smallworld server. Start the FME Connection Service using the following magik command:

fme connection service.start (30000, unset, :gis)

See the section Starting the Smallworld GIS above.

Test: FME Connection Service

Objective Test the connection between FME and Smallworld

Follow these steps to test the connection to the Smallworld database, and inspect the data in the
FME Data Inspector.

It is useful to view Smallworld data using the FME Data Inspector because this allows you to:
e Inspect the data prior to translation
e Determine how FME “sees” or “represents” the Smallworld data
e Determine what data structures need to be created to successfully import data back into
a Smallworld VMDS.

1) FME Data Inspector
Start FME Data Inspector—Go to Start > All Programs > FME Desktop 2015 > FME Data
Inspector or use the FME Data Inspector short cut on your taskbar.

Select F|Ie > Open Dataset &% Select Dataset To View td_hJ
Reader
Enter the reader format parameters . p—— =i
Reader Format: Smallworld 4
Dataset: localhost:30000
Parameters... | Coord. System: BritishNatGrid_mm - EI
Enter the Coord. System: Select BritishNatGrid_mm Help Cancel

2) Enter Database Connection Parameters
Click on the Parameters button and enter the Smallworld
database connection parameters:

Database Connection
Server Host:  localhost

Server Port: 30000

Server Host: localhost _
SerVer POI"[Z 30000 Service: FME
Service: FME Username:
Username: (blank) Password:
Password: (blank)

Connecting to the Smallworld Database Page 11
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Constraints
3) Open Table L|St Expose Internal Tables
Still in the Parameters dialog, click on the browse button Teble List: (-
next to Table List RlErzE
Checkpoint:
[ Select Feature Types L&J WHERE Clause: LI
BY clecriciycable = 4) Select Tables to View
ElectrnCity.joIn -
7 electricitt;Jsuhstation The Select Feature Types dialog appears.
| electricity.supply_point
Y| gis.mi d - “ R ([P ] e
diemographics aren In the Filter text box, enter “electric” or “gis” to filter the
:emosrap:ics‘;_onstru_ctio_n list of feature types.
emograp 1cs, ImEI"ISIUHII"Ig .
demographics.district Select each of these feature types:
demograph?cs‘dra&?ng_a.reas ° elect”CltyCable
demographics.drafting_lines - .. ..
a R . electricity.joint
=
a e . electricity.substation
QK Ci | .. .
Lona ] electricity.supply_point
o gis.min_road

Click OK to close the Select Feature Types dialog

5) Use Search Envelope
Check the Use Search Envelop and enter:
e  Minimum X: 545000000
e  Minimum Y: 259000000
¢ Maximum X: 547000000
¢ MaximumY: 261000000
These search envelope values are in the source data units of measure — millimeters in this case
since the Smallworld world coordinate system is British National Grid mm.

You'll probably use these values again so select Defaults — Save as My Defaults.

Click OK to close the Parameters dialog. Click OK again, to open the dataset in FME Data
Inspector

Connecting to the Smallworld Database Page 12
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&5 FME Data Inspector [E=E—

File View Camera Tools Settings Window Help

Ed RacCcPrEile@i QA Qn @ @IV

[Feature Information B X | View1

Features Selected: 1 0fl €« » N \
Property Value =
Feature Type electricity.supply_point... S |
Coordinate System BritishNatGrid mm e |
Dimension 0 % = g
Number of Vertices 1 @ 1
Min Extents 546479693.0, 26088309... 2}\ |
Max Extents 546479699.5, 26088309... ‘%
4 Attributes (33) = d
customer (encoded: utf-16) 268910387
customer_class (encoded: utf-16) Private \
fme_db_operation (encoded: utf-16) %\
fme_geometry (string) fme_point %‘K;
fme_rotation (64 bit real) 00 ‘2:\ N
fme_text_size (64 bit real) 10 % %,
fme_text_string CAM-910388-5P \ = N
fme_type (string) fme_text A\ {
id (encoded: utf-16) CAM-910388-5P Montrose |
sworld_geom_type (string) sworld_text House

sworld_geometry{0}.sworld_geom_type (st... sworld_text
sworld_geometry{0}.sworld_horiz_just (stri... 2
sworld_geometry{0}.sworld_name (string)  label
sworld_geometry{0}sworld_orientation (st...
sworld_geometry{0}.sworld_scale (64 bit re... 1.0
sworld_geometry{0}.sworld_text_height (st.. 1
sworld_geometry{0}.sworld_text_string (stri.. CAM-910388-SP
sworld_geometry{0}.sworld_type (string) sworld_text
sworld aeometrvQlsworld vert iust (strina) 2 Tiles Courtesy of MapQuest
Feature Information | Display Control |

[Table View & x
id customer_class customer fme_db_operation Al
1 CAM-910422-SP Private 268910421 K|
2 CAM-910405-SP Private 268910404
3]
4 CAM-909157-SP  Private 938312
5 CAM-909153-SP Private 938278
6 CAM-909113-SP  Private
7 CAM-909149-SP  Private 938126
8 CAM-909117-SP_ Private =
Q in [any column ) Lselected / 64row(s)
lectricity.cable_centreline_v _location_hv_| _location_lv | _electridty.substation_annotation | ek b Llocation | _ electricty.supply_point_label | electricity.supply_point location | gis.min_road_centre line |[4]/)

| Table view | Log |
SPHERICAL_MERCATOR  X: 14526.0808 Y: 68397539328

If you don’t see the background map of the City of Cambridge then you probably need to
configure Background Maps in FME Data Inspector.

6) FME Data Inspector Background Maps
Select Tools -> FME Options. Under Background Map Format select MapQuest Web Map Tile
Service and under Parameters... select Open Street Map.

7) Data Inspection

Select the inspection tool and click on the various features to see how FME represents the
Smallworld objects with individual attributes and geometry in the Table View and the Feature
Information window. In the Feature Information window, note the sworld_geometry{} list attribute.
More about the sworld_geometry{} list attribute later.

Check the Display Control tab in FME Data Inspector to see the list of feature types.

Connecting to the Smallworld Database Page 13
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Display Multiple Geometries

Smallworld objects often have multiple geometry columns, for example centreline & annotation.
FME can preserve the multiple spatial column structure, or simplify the geometries.

When you configure the Smallworld reader, the Service parameter lets you select whether you
will preserve multiple spatial columns or have FME simplify the geometries. The Service
parameter options are:

FME Simplify geometries

FMENOFACTORY Preserve multiple spatial columns

Service: FME

Using Service: FME simplifies the Smallworld objects so that they are more compatible with most
other GIS and CAD formats. Smallworld objects that contain multiple geometries are split into
separate features with different FME feature types, one feature type for each geometry. For
example, the Smallworld rail_line object with line and annotation geometries will become the FME
feature types gis.rail_line_centre_line and gis.rail_line_annotation. Similarly a Supply Point object
will be split into two features, electricity.supply_point_location and electricity.supply_point_label.

Service: FMENOFACTORY
The FMENOFACTORY service produces the “raw” Smallworld objects. The multiple geometries
from the Smallworld objects are represented as aggregates on the FME features.

Displaying the “raw” Smallworld objects in FME Data Inspector is one way to determine how you

need to structure the data in FME Workbench so that it will upload to Smallworld successfully. It's
also useful if you're replicating your data in a database such as Oracle which has multiple spatial
columns.

In the previous example you used the default parameter Service: FME. The next example
illustrates Service: FMENOFACTORY.

1) Start FME Data InspeCtor . rﬁ"} Select Dataset To View ldh,l
Back in FME Data Inspector, Select File > Open
Dataset. Reader B
Format:  Smalworld 4 - Ll

Enter the reader format parameters B oot 30000
Reader Format: Smallworld 4 Parameters... | Coord. System: BritshiNatGrid mm  + [..]
Coord. System: BritishNatGrid_mm o ——
2) Enter Database Connection Parameters s o
Click on the Parameters button and enter the

. Server Host:  localhost
Smallworld database connection parameters:
Server Host: localhost SSSERRE 0000
Server Port: 30000 Service: FMENOFACTORY ‘_
Service: FMENOFACTORY Lz
Username: (blank) Password:
Password: (blank)

3) Open Table List
Still in the Parameters dialog, click on the browse button next to Table List

4) Select Tables to View
The Select Feature Types dialog appears. Notice that only the main table names are available
from this service.

Connecting to the Smallworld Database Page 14
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Choose the same objects as before:
e electricity.cable
e electricity.joint
e electricity.substation
e electricity.supply_point
e gis.min_road
Click OK to close the Select Feature Types dialog

Select the same Search Envelope values as before:
545000000 259000000 457000000 261000000

Click OK to close the Parameters dialog
Click OK again, to open the dataset.

6) Inspect the Dataset

Use the table view or the inspection tool to select an electricity.supply_point feature. You can see
the feature attributes and the geometry. The geometry of the feature is an fme_aggregate with
two parts, a location and a label (listed under IFMEAggregate):

® Text Location

Property Value
Feature Type electricity.supply_point
Coordinate System BritishMatGrid mm
Dimension 20
Mumber of Vertices 2
Min Extents 545924686.0, 260235479.0
Max Extents 545927668.5, 260239858.0
4 Attributes (6)
customer (encoded: utf-16) 938074
customer_class (encoded: utf-16) Private
fme_db_operation (encoded: utf-16)
frne_geometry (string) frne_aggregate
fme_type (string) fme_collection
id (encoded: utf-16) CAM-209081-5P
4 4% IFMEAggregate (2 Parts)
Front Appearance Reference <inherited_or_default_appearance=
Back Appearance Reference <inherited_or_default_appearance>
4 @ Part 0: IFMEPoint 5450246864, 260235479.0
Mame (encoded: utf-8) location
4 T Part 1: IFMEText AR O0a08] - 5P
Mame (encoded: utf-8) label
Encoding Mame frme-system
Text Rotation (degrees CCW) 0.0
Text Size 1.0

545927662.0, 260239857.0

Connecting to the Smallworld Database
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The geometry parts of a feature will vary, depending on the object you select. For linear features
such as the electricity.cable, the Smallworld chain and sectors are represented in FME as a path
and segments (sometimes called a complex edge in network applications). The path is
equivalent to the Smallworld chain and each sector is represented as a segment of the FME
path. Select the cable:

known_as = Union Lane LV
This is a multi-sector chain in Smallworld.

If your Smallworld geometries also contain circular arcs, they will be preserved. Other types of arc
(elliptical, spline, etc.) are stroked.

Connecting to the Smallworld Database Page 16
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Smallworld Geometry

The Smallworld geometry representation in FME is made-up from three parts:
e Smallworld geometry field (geometry name and type)

e FME geometry aggregate
o sworld_geometry{} list attribute

The sworld_geometry{} list attribute describes the structure of the geometry aggregate and is
used to link the FME geometry to the Smallworld geometry field when writing objects to
Smallworld. In the Supply Point example above the FME Aggregate has two parts:

Part0 FME Text label
Part1 FME Point location

The sworld_geometry{} list attributes describes the associated geometry name and any geometry

characteristics, such as text orientation.

Again, in the Supply Point example above:

sworld geometry{l}.sworld name

(string)

location

indicates that the second geometry in the aggregate is the location spatial column. Similarly,

sworld geometry{0}.sworld name

(string) label

indicates that the first part of the FME aggregate is the label spatial column. The
sworld_geometry{} list attributes describe specific characteristics of the text geometry.

Property
Feature Type
Cooerdinate System
Dimensicn
Murnber of Vertices
Min Extents
Max Extents
4 Attributes (17)
customer (encoded: utf-18)
customer_class (encoded: utf-16)
fme_db_operation (encoded: utf-16)
fme_geometry (string)
fme_type (string)
id (encoded: utf-16)
sworld_geometry{0L.swerld_horiz_just (32 bit integer)
sworld_geometry{0L.sworld_name (string)
sworld_geometry{0}.swerld_erientation (84 bit real)
sworld_geometry{0L.sworld_text_height (64 bit real)
sworld_geometry{0}.swerld_text_string (string]
sworld_geometry{0L.sworld_type (string)
sworld_geometry{0}.swerld_vert_just (32 bit integer)
sworld_geometry{1}.sworld_name (string)
sworld_geometry{1}.swerld_erientation (84 bit real)
sworld_geometry{1l.sworld_scale (64 bit real)
sworld_geometry{1}.sworld_type (string)
IFMEAggregate (2 Parts)
Front Appearance Reference
Back Appearance Reference
4 T Part 0: IFMEText
Encoding Mame
Text Rotation (degrees CCW)
Text Size
@ Text Location
@ Part 1: IFMEPoint

Value
electricity.supply_point
EritishMNatGrid mm

20

2

5458168596.0, 260087457.0
345922843.5, 260092849.0

Private

frne_aggregate
fme_collection
CAM-909269-SP

2

label  f—
0.0

1.0

CAM-909269-5P
sworld_tesxt

2

location
-138.13807611427166
1.0

sworld_point

<inherited_or_default_appearance>
<inherited_or_default_appearance>
CAM-909269-5P

frne-system

0.0

1.0

545922837.0, 260092848.0
545919896.0, 260087457.0

Connecting to the Smallworld Database
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Export Examples

Export examples illustrate some of the typical issues associated
with how Smallworld objects can be represented on other formats

Export to FME Feature Store (FFS)

FME Feature Store (FFS) is the internal FME format. It's useful to write Smallworld objects to FFS
as this format maintains much of the complex structure of the Smallworld data, including multiple
geometries and sectors. If you ever need to send Safe support an example of your Smallworld
data, this is the best format to use.

Example 1: Write to FME Feature Store (FFS)

Scenario FME user

Data Electricity facilities and minor roads

Overall Goal Read Smallworld data and write to FME Feature Store format

Demonstrates Smallworld multiple geometry objects represented as FME feature aggregates

Starting Workspace | Create from scratch

Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld1-Complete.fmw
Workspace

This example also shows how to preserve the Smallworld multiple spatial columns in an FFS
dataset.

1) Generate Workspace
Start FME Workbench. Select the option to Generate workspace.

Reader Format: Smallworld 4
Reader Dataset: localhost:30000
Reader Coord Sys: BritishNatGrid_mm
Reader Parameters

Service: FMENOFACTORY

2) Select Tables to View
The Select Feature Types dialog appears.

Select each of these feature types:
e electricity.cable e electricity.supply point
e electricity.joint e gis.min_road
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| e electricity.substation | .

Click OK to close the Select Feature Types dialog

3) Use Search Envelope
Check the Use Search Envelope and enter:
e  Minimum X: 545000000
e  Minimum Y: 259000000
e Maximum X: 547000000
e MaximumyY: 261000000

SAFE SOFTWARE

Note that these values are in mm to match the BritishNatGrid_mm coordinate system.

4) Set the Reader Defaults

At the bottom of the Smallworld 4 Parameters dialog, select the Defaults option and set “Save as

My Defaults”. This will save your parameter settings for future use.

5) Writer Parameters
Writer Format: FME Feature Store (FFS)

Writer Dataset: C:\FMEData2015\Output\Cambridge.ffs

Click OK to generate the workspace.

{ electridty. substation: [SWORLDSWAF] ]

{ electricity. substation: Cambridge [FFS] ]

L4
@] b electri...station {5 -
,/-b'ecl....tu-k.
.\‘.p electricity.joint 076
.\E. b electr.._point {0tk

[ — o
\E. b gis.min_road Gt

4) Run and Inspect Output
Run the translation.

Inspect the output in the FME Data Inspector.

f—./
# b electri...station 5w | |
T8 =)

-

rrrrsr——
- —Y \
s electricity.joint 425| \.t’/
%= > elect int 404 =)
¥ I electr.._point 0: |

_p -»!/.

— -
%+ b gis.min_road 40 .!/,

(= ; X ._r . -
@ P electri...y.cableichie # b electri...y.cableiCh wy )
\‘—\__
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Property
Feature Type
Coordinate System
Dimension
Number of Vertices
Min Extents
Max Extents
4 Attributes (11)
fme_db_operation (encoded: utf-16)
fme_feature_type (string)
fme_geometry (string)
fme_type (string)
id (encoded: utf-16)
known_as (encoded: utf-16)
length (64 bit real)
multi_reader_keyword (string)
multi_writer_id (string)
status (encoded: utf-16)
voltage (encoded: utf-16)
4 4% IFMEAggregate (1 Part)
Front Appearance Reference
Back Appearance Reference
4 ™\ Part 0: IFMEPath (28 Segments)
Name (encoded: utf-8)
Closed
V| Segment 0: IFMELine (2 Coordinates)
> | Segment 1: TFMELine (2 Coordinates)
- V| Segment 2: IFMELine (2 Coordinates)
> V| Segment 3: IFMELine (2 Coordinates)
© ¥ Segment 4: IFMELine (2 Coordinates)

Value

electricity.cable
EritishNatGrid mm

2D

34

545899295.0, 259848987.0
546247721.0, 260185703.0

electricity.cable
fme_aggregate
fme_line

914782

Union Lane LV

488 6231554205155
SWORLDSWAF 1

0

In service

v

<inherited_or_default_app...
<inherited_or_default_app...

centreline
No

IDEEEID

m

Use the select tool to select the Union Lane LV
cable.

Notice the path geometry and the path segments
that represent the original chain and chain sectors
from Smallworld.

Select one of the Supply Point features
Notice how the multiple geometries of the
Smallworld object are represented by an FME
aggregate.

s ™)
Writing to FFS is essentially a “dump” of Smallworld objects. If the translation to
FFS fails, then there are probably errors in the Smallworld data.

\ J

s ™)
Using FFS files is a good way to send “raw” Smallworld data to the Safe Software
support team.

\ J
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Export to Esri File Geodatabase

The Esri Geodatabase format supports only one geometry per feature class. When the
Smallworld FME service is used with the Esri writer, FME Workbench automatically will generate
separate reader and writer feature types for each geometry on the Smallworld object.

Example 2: Write to Esri Geodatabase

Scenario FME user

Data Electricity facilities and minor roads

Overall Goal Read Smallworld data and write to EsriGeodatabase

Demonstrates Smallworld multiple geometry objects represented with distinct FME feature
types

Starting Workspace | Create from scratch

Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld2-Complete.fmw
Workspace

1) Generate Workspace
Start FME Workbench. Select the option to Generate workspace.

Reader Format: Smallworld 4
Reader Dataset: localhost:30000
Reader Coord Sys: BritishNatGrid_mm
Reader Parameters
Service: FME e —
Table List: electricity.cable
electricity.joint
electricity.substation
electricity.supply_point
gis.min_road

You only need to select the object names; FME will automatically include their
multiple geometries.

Use Search Envelope
Minimum X: 545000000
Minimum Y: 259000000
Maximum X: 547000000
Maximum Y: 261000000

Writer Format: Esri Geodatabase (File Geodatabase API)
Writer Dataset: C:\FMEData2015\Output\Cambridge.gdb
Writer Coord Sys: BritishNatGrid
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Be sure to specify the Smallworld reader Service: FME and the different reader and writer
coordinate systems as shown.

Click OK to generate the workspace.

[ elactricty substation: [SWORLDSMAF] ] [ electricity_substation: Cambridge [FILEGDE] ]
[d L

[ - — ~ — -
@. » eledri. station{%e — b elecirl_ S@HoN <) (wy |
% —
/j . » s
k\ﬁ » eledr.fation {SH— % p eledr. tation {:}l/'.ij'
- A=
—. ——————————T7 "
I\/i. » eledr. @tion {3k # b eledr.cation il )
- - -, I ————
@. » eleds.._point {7 —#» eledr.._point 3wy |

2) Run and Inspect Output
Run the translation. Inspect the
output in the FME Data Inspector.

- p v
(@p eledr. .ation {9}::. & b eladr_cation {;}l‘,‘i}l
e A =
I(E. » eledi. .t label {5k % b eledri. £ label i \.,/l
& FME Data Inspector = | E

File View Camera Tools Settings Window Help

Pl R cErElIe@QAQAQE 0 @Y

Feature Information 8 %| [ views x| View2
Features Selected: 1 0oft ¢ »
| Property Value e
Coordinate System BritishNatGrid
Dimension
Number of Vertices E"
Min Exents 545899.29499999903, 259848.98699999973
Max Extents 546247.7200999999, 260185.70299999975
| 4 Attributes (10)
| filegdb_type (string) geodb_polyline
fme_db_operation (encoded: utf-16) A [ous
fme_geometry (string) fme_line 1
fme_type (string) fme_line
id (encoded: utf-16) 914782
known_as (encoded: utf-16) Union Lane LV
length (64 bit real) 488.6231554205155
OBJECTID (32 bit unsigned integer) 35
status (encoded: utf-16) Inservice
voltage (encoded: utf-16)
| 4 W IFMELine (34 Coordinates) =)
Closed No
4 Coordinates (34) Coordinate Dimension: 2
0 545899.20499999993, 260185.70299999975
1 545919.41500000004, 260175.2620000001
2 545922.63800000027, 260173.58999999985
3 545926.15699999966, 260171.76400000043
4 545936.61699999962, 260159.45800000057
5 545942.24399999995, 260152.83699999936 \
6 54596, 60148 % Sourtasy of MapOuest
Feature Information | Display Control | \

[Table View
id known_as voltage status length fme_db_operation OBJECTID

33 938249 w In service 25.8824420795256 33

34 938776 v In service 19.2354713225333 En

35]

36 929239 v In service 19.4817114751246 E]

37 920930 Lower Milton R... LV In service 206.164650099947 37

38 939018 W In service 121776389337178 E

39 939001 W In service 12.2994660046687 39

40 939035 v In service 12 ) =
Q in (any column - 1 selected / 70 row(s)

| electricty_cable_centreine v | electrity_joint location_hv | _electrity_joit location Iv | electriaty_substation_annotation | _electricity_substation_location | _electriity_supply_point label | _electriity_supply_point location | gis_min_road_cer{4][¥ |
Table view | Log |

SPHERICAL_MERCATOR _ X: 147404732 V: 68401083132

Notice how separate feature types are created for each geometry on the single Smallworld object.
Use the inspection tool to select the Supply Point location and then the Supply Point label point.
Observe that these two features representing the same Smallworld object are related by id.

3) Modify Workspace (Advanced)
This is typically where you’d do some more sophisticated schema mapping to represent your data
in a more structured way in the Esri Geodatabase. This might include:

¢ Merge Supply Point high and low voltage features

e Map HV & LV to subtypes or domains

e Create annotation feature classes

e Relationship feature class
See the workspace:
"C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld2-CompleteAdvanced.fmw" for
some ideas.
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The Esri Geodatabase (File Geodatabase API) writer only has limited support for point, lines and
areas. To gain the full benefits of the Esri Geodatabase, you can use the Esri Geodatabase (File
Geodb ArcObjects) writer, provide you have ArcGIS installed and an ArcGIS license.

Export to Autodesk AutoCAD 3D Map

AutoCAD supports only one geometry per feature, but you can have features with different
geometries in the same layer. When the Smallworld FME service is used with the AutoCAD
writer, FME Workbench automatically will generate separate reader and writer feature types for
each geometry on the Smallworld object.

Example 3: Write to Autodesk AutoCAD

Scenario FME user

Data Electricity facilities and minor roads

Overall Goal Read Smallworld data and write to AutoCAD

Demonstrates Ensure that all Smallworld attributes are written to AutoCAD

Starting Workspace | Create from scratch

Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld3-Complete.fmw
Workspace

1) Generate Workspace
Start FME Workbench. Select the option to Generate workspace.

Reader Format: Smallworld 4
Reader Dataset: localhost:30000
Reader Coord Sys: BritishNatGrid_mm
Reader Parameters
Service: FME S —
Table List: electricity.cable
electricity.joint
electricity.substation
electricity.supply_point
gis.min_road

Use Search Envelope
Minimum X: 545000000
Minimum Y: 259000000
Maximum X: 547000000
Maximum Y: 261000000

Writer Format: Autodesk AutoCAD Map 3D DWG/DXF
Writer Dataset: C:\FMEData2015\Output\Cambridge.dwg
Writer Coord Sys: BritishNatGrid

Click OK to generate the workspace.
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[ electricity.substation: [SWORLDSWAF] ]
¥

[ electricity. substation: Cambridge [AUTOCAD_OD] ]

~X

p= S S——
- - ——t o - o -
\t.; > electri...station LE’_(r —\D electri...station ek I,\.:,/_.
(o) slect.cation 15 b clectetation 11w )
| electr...tation {05k I electr..tation ) )
\! > s ! £ \?’/
'{:mh eﬁ/ -
electr...cation 1 ¥ > electr..cation <0 )
.\!:. b ¥ {5 Ib!/.
{ electricity.supply_point: [SWORLDSWAF] ] [ electricity.supply_paint: Cambridge [AUTOCAD_OD] ]
p L —
T E———T T ——
( | electr..._point {0tk %+ b electr.._point {0 mp | )
Lo _point {1 tP elecic.._point {{uy )
f— o . 7 -
( p electr...cation ik 5 | electr..cation 04wy | |
\@»J b oH -v?/.

".: : 3 -
(.:. b electri...t_label {cte # b electri...t_label 5t .,/'
— - —

2) Modify Workspace
You need to truncate some of the long layer names;
electricity.cable_centreline_hv
electricity.cable_centreline_Iv
Layer names in AutoCAD are limited to 30 characters so they will need to be renamed.

3) Run Translation
Run the translation.
Inspect the output in the FME Data Inspector.

This is typically where you’d do some more sophisticated schema mapping to represent your data
in a more structured way in the AutoCAD file. This might include:
e Merge Supply Point high and low voltage features
Merge Supply Point labels into the same layer as the Supply Point locations
Use an AutoCAD template file to define the structure of your AutoCAD file
Use the DWGStyler to add symbology such as blocks, line styles etc.
Write a coordinate system .prj

See the Smallworld3-CompleteAdvanced.fmw for some ideas on expanding your workflow.

Data Export Summary

In summary, it’s pretty straightforward to extract data from GE Smallworld. Gotchas are:
e Make sure the FME connection service is running in Smallworld

e Coordinate system — using a world coordinate system . And make sure you have set the
coordinate system.

e Multiple vs. Single geometry export using Service: FMENOFACTORY or FME
respectively

e Schema mapping of the results to the output schema
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Import Examples

Import examples illustrate some of the issues associated with
importing data into Smallworld, including handling multiple
geometries and database operations

Considerations for Import

FME can’t create new objects in the Smallworld database. You can only load into existing objects.
This means that on import, the FME Smallworld writer data schema must accurately match the
existing Smallworld object schema. It's useful to obtain a descriptive CASE report of the
Smallworld objects that will receive the imported data.

Steps for Successful Import

1. Identify the correct Smallworld alternative or version to import into.
FME will make the alternative writable

2. Use FME Data Inspector with the FMENOFACTORY service to inspect existing
Smallworld records in the target object. Take note of the data schema that will need to be
created in the FME workspace

3. Create the FME workspace in FME Workbench to translate the source dataset schema
into the destination schema on the Smallworld objects

4. Test the workspace using the ‘Redirect to Inspection Application’ menu option, to ensure
that the data is restructured as planned

5. Import the data into a test alternative and check the results

6. Import the data into the production alternative or “top” alternative — consider setting a
checkpoint before you run FME so you can rollback if needed

7. Inspect the updated Smallworld objects to verify that the imported data is loaded
correctly.

Before starting any data import, you should inspect both the source dataset in the
EME Data Inspector and the Smallworld objects to obtain a full understanding of
the data schemas.
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Import Simple Geometries

The Electricity Cable objects in the Smallworld database have a single Centreline geometry.
You're going to import some Proposed cables for a new sub-division into the Cambridge
database from an AutoCAD 3D Map dataset.

Example 4: Import Single Geometry Objects to Smallworld

Scenario FME user

Data Smallworld Electricity.Cable; Cambridge database inserts

Overall Goal Insert new Smallworld electricity objects from feature update data
Demonstrates How to import single geometry objects into Smallworld

Starting Workspace | Create from scratch

Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld4b-Complete.fmw
Workspace

First, inspect the destination Smallworld objects and the source AutoCAD dataset.

1) Inspect Source Dataset
Open the FME Data Inspector. Click on File > Open Dataset:

Using FME Data Inspector, open the source dataset:

"C:\FMEData2015\Resources\Smallworld\sourceData\electric_networkProposed.dwg
The AutoCAD file cable has a status attribute “In service” and “Proposed”. You'll only import the
proposed cables as the “In service” cables already exist in the Cambridge database.

In this case, because there is a .prj file in the same directory as the .dwg file, the coordinate

system for the AutoCAD drawing can be determined — BritistNatGrid (meters)

2) Compare Electricity Cable in Smallworld and FME Data Inspector
Using the Smallworld Application Manager, open the Professional - Smallworld Core application

and inspect the Cambridge sample ] Pofsior Sl o =
database. [Gem ot B L e L L L L
%+ @a oo on/iz ] [oeal v B [Brtoh NatonalGrd v

Object Cortrol Ednw\
Ah T EARe >
2K <k - @ Soeas

@2 [Hecticty] Cable

Milton Road

Pakenham Close

Field rame Value

e Use the bookmark: Electric Network

we E—
to zoom in on the Cambridge electric QD{'ZKM m
network data e e
e Choose the Select Mode tool and click
on the “Union Lane LV” cable object
e Check the object Editor for the cable =l

attributes and geometry

O SIRE XD v v i~ L8 8|+ 1f | [Seomenilongh [Seomert beaing [Kooodinate |V coortinale
o

select geometry ordragtopan  [Cable( Lower Miton Rd LV ) Centreline Lv Centre: 5459387 [ I*1I*]
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In the FME Data Inspector. Click on File > Open Dataset:

-
Reader Format: Smallworld 4
Reader Dataset: localhost:30000 7
Reader Coord Sys: BritishNatGrid_mm
Reader Parameters
Service: FMENOFACTORY
Table List: electricity.cable
e Zoom in to the same area as above
e Choose the Select Features tool and
click on the “Union Lane LV” cable S e \ \ N
feature T N7
Compare the Smallworld and FME o i T —
representations of the electricity.cable. a2
In FME the cable geometries are
represented by a single geometry s prcon x saun . iz
(centerline) - in the case of “Union Lane LV” a multi-segment path geometry.
3) Inspect Destination Schema
In the Smallworld GIS, use the Editor to inspect the 0 EIEIELS
electricity.cable objects schema. Notice that the sys_id field is Field name by | vl BIE
named ‘id’ is the key field. If you look at a CASE report of the e e T
electricity.cable it is a mandatory field. = Vakags Lv -
The Status attribute is an enumerated list with possible values: f Lengh 2676m :
In service // Centrline v
Abandoned
Accepted
Out of service
Proposed
Removed
The voltage attribute is an enumerated list with possible values:
11kV
132kV
inv

When loading the Status or Voltages attribute, you need to ensure that one of these mandatory
enumerated values is set.

Take note how the source schema relates to the destination schema:

Source Destination Action

AutoCAD Smallworld

id id Match FME feature with Smallworld object

length -- Not updated because calculated field

known_as known_as

status status Make sure value matches enumerated
values

voltage Voltage

Geometry

fme_line Centreline
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In this example there is not much schema mapping is involved. In most cases you’d need to add
some FME schema mapping transformers such as AttributeRenamer, AttributeValueMapper,
AttributeCreator or SchemaMapper.

4) Select the Smallworld Destination Alternative
In the Professional - Smallworld Core application, click on File > Versions to open the Version
Management application.

In the Version Management application, add a new ‘alternative’, if it doesn’t already exist:

Dataset Name of Alternative
Electricity fme_training
Double click on the alternative to make it the current alternative.

5) Generate Workspace
Open FME Workbench. Choose the Generate Workspace option.

Reader Format: Autodesk AutoCAD Map 3D Object Data
Reader Dataset:
"C:\\FMEData2015\Resources\Smallworld\sourceData\electric_networkProposed.dwg"

Reader Coord Sys: BritishNatGrid (actually this is optional since the esri_cad.prj exists)
Reader Parameters
Expand Blocks into Entities uncheck » [[] Prepend Table Name
4 || Expand Blocks into Entities "'
When you uncheck the Expand Blocks into Use Block Feature Type for Companents
Entities, FME will only read the insertion point for Use Block Layer Information for Components

that block, and will not read the block definition.
This is usually what you want when loading CAD data into a GIS.

Writer Format: Smallworld 4 &% Generate Workspace N [i_E-J
Writer Coord Sys: BritishNatGrid_mm Reader
Wntgr Parameters Format:  Autodesk AUtoCAD Map 3D Object Data - [
Service: FME _ N
. - Dataset: orld\sourceData\glectric_networkProposed.dwg U @
Alternative: [fme_training ram] ) coot o
- P ters. .. | C . System:  Unknown T e
(Be sure to use the | symbol as the first character) (Peremeters. | (B coor. system
Writer
In the Generate Workspace dialog, place a checkmark Format:  Smalworld 4 - [
on the Dataset: localhost: 30000
“Import feature type definitions” checkbox. ——E ey e B
V| Import feature type definitions ‘_
Click OK.

Workflow Options

@ Static Schema Dynamic Schema

\ )
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6) Import Writer Feature Types from Smallworld

The “Import Writer Feature Types” dialog will
appear. Enter the usual Smallworld connection
parameters.

Click on the Parameters button, and select:
Table List: electricity.cable

Click OK to close the import feature types
dialog.

7) Select AutoCAD Layers

The Select Feature Types dialog will open. This
is the AutoCAD layer selection. Select
electricity_cable and OK, to generate the
workspace.

==

&% Select Feature Types

Eve

electricity_cable

[T electricity_joint

(=] electricity_substation
[T electricity_supply_point
[ gis_min_road

[ gis_park

[] mapbase_building

=] mapbase_lotlines

Q, Filter Select all Sorted

)

&% Import Writer Feature Types %

Reader
Format:  Smallworld 4
Dataset: localhost: 30000

T 1 [em] a ie.

(Y Smallworﬁ 4 Parameters

n

123
Database Connection

Server Host:  localhost
Server Port: 30000
Service: FMEMOFACTORY

Username:;
Password: Enter a password
Constraints
Expose Internal Tables: [
Table List:  electricity.cable
Alternative:
Checkpoint:

WHERE Clause:

Expart Changes from Baseline: [~

Hep | [ Defauls ~ ok

Smallworld writer is added.

\feature type schema.

It is advisable to use the Import Writer Feature Types option whenever a

The Smallworld schema will generally be different to the reader schema, and the
correct schema can only be obtained by explicitly importing the Smallworld

8) Save Workspace
Save the workspace locally at

<My Documents>\My FME Workspaces\Smallworld4.fmw

9) Connect Reader and Writer Feature Types

Connect the electricity _cable reader feature type to the new electricity.cable writer feature type.
Expand the attribute lists for the reader and the writer.
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[ electricity_cable: electric_networkProposed [AUTOCAD_OC] ] [ electricity.cable: [SWORLDSWAF] ]

- Y — The Smallworld writer exposes all the
1y /—.f/ \ ‘ ’ .
@jvelectr..._cable i i velemn...y.cable{’g}\.ﬁ:} mapped’ geometries on the
— . ’ \._.é\__ .. . .
::1 g -‘*::]7 electricity.cable object (centerline_Iv,
0Wn_as " = known_as H
length 4 M centerline_hv, etc.) as well as the
status > sEus physical geometry — centerline. FME
| voliage g Prlimehseiing will only import into the physical
¥ centreling_hv .
o comelinady | geometry, centerline.
I} = centreli...inacive
_> ¥ centreline

¥ centreline v

10) View Geometry Attribute
Click on the parameters button for the electricity.cable writer feature type.

Click on the User Attributes tab. Notice that the data type for the centreline attribute is
‘sworld_chain’, FME’s name for the Smallworld ‘chain’ geometry type.

The centreline attributes represent Smallworld geometry fields and so are never populated
directly with attribute values. Instead their values are loaded automatically by FME from the
feature geometry. The connection between the Smallworld geometry field (i.e. centreline) and the
FME geometry is made using the swoeld_geometry{}.sworld_name attribute that you saw earlier
in the FME Data Inspector and is described below.

This means that the input ports for the centreline, and other geometry field attributes, will always
be unconnected and red.

Click OK on the feature type parameter dialog.
11) Filter the Proposed cables

You only need to insert the proposed cables. Add a Tester transformer to filter out the “In service”
cables (or conversely keep the “Proposed” cables).

12) Set Geometry Name réj AttributeCreator Parameters li:hJ
Add an AttributeCreator transformer to your
workspace and add the attribute Transformer
SWOfld_geometry{O}.SWOfld_name Transformer Name: AttributeCreator
Centl’eline > [ Multiple Feature Attribute Suppart
sworld_name connects the FME geometry to the Attrbutes To Set
centerline geometry field. Attribute Name b Value
4 sworld_geometry{0}.sworld_name Pk centreline
Notice that the geometry name ‘centreline’
needs to be spelled in UK/Canada English, not
‘centerline’.
+ — - ~ = x Duplicate
=
TEST @value(status) = Proposed
Condition: OR
L
[ electricity_cable: electric_networkProposed [AUTOCAD_OD] ]
(& ¥ electr..._cable 46— 146 —pi Tester &) w electri...y-cableZd ;\]
- ’ o b e e—
known_as (» Failed 3 B knownas
SERe ributeCreator {0+ 120 |
| voltage J \A“—\/ = centreline_hv . . .
il b cortrlne.dv Your workspace should look something like this:
—
b= centreline v |
b+ svorid_.d_name |
= fme_db_ration
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13) Save and Run

Save the workspace. Run the translation.

Inspect the updated data in the Professional -

Smallworld Core application. The proposed cables

have been added along Oak Tree Avenue. You
might have to select View — Refresh.

In the Smallworld GIS, open the Smallworld Explorer
(Tools = Explorer...). Open the folders Electricity,

Electricity Network and select Cable.

Milton Road

@ Explorer - Smallworld Core - \My Datasets\Electricity\Electricity Network\Cable

File Edit View Object Help
= eI R a5 @
Address ‘My Datasets'Hectricity\Electricity Network\Cable j ﬁ
Foldzrs x |d Known As Vot... | Status Length | Centrelin =
=3 Explorer . 939188 LV Inservice 21.07m e
=% Map Selection 539205 LV Inservice 2122m /s
[3] Cable 939222 LV Inservice 19.78m
=-[@ My Datasets 535235 LV Inservice 1548m rd
=3 Gis 268910167 11kV  In service H0Zm re
=63 EBlectricity 268910358 LV In service 79.81m Ve
= @ Hlectricity Network 268910386 LV In service 0.00m
8 m 268910332 LV In service 613m Ve
1591 Customer 268910409 LV Inservice 6.15m rd
(31 doirt 268910426 LV Inservice £26m Ve
8 Substation 268910438 11V In service 11 ﬂ m pd
Ea Substation Intemals Link 857296098, Ozk Tree Avernue LV v Proposed 1289m
8 Supply Point 857296098... Oak Tree Avenue LV Lv Proposed 543m Ve
e @ Drawing 857256038... Osk Tree Avenue LV LV Proposed 6.05m rd
4 @ Substation Intemals 857296098... Oak Tree Avenue LV LV Proposed E34dm Ve
@ My Themes 857296098 Oak Tree Avenue LV Lv Proposed 724m Ve
+ g Scrapbook 857296098... Oak Tree Avenue LV LV  Proposed 41.70m Ve
@ Search Restrictions 857296098... Oalk Tree Averue LV LV Proposed 13.88m Ve
< + o= 3
Cable Number of Records: 1

\

J

Union Lane

Pakenham Close

Problems?

The most common data load
error is not loading the
Smallworld geometry correctly.

In Smallworld Explorer, if the
geometry column is not flagged
or the Length is 0.0, then you
have probably not set the

sworld_geometry{0}.sworld_name correctly which means the link between the FME geometry
and the Smallworld geometry field will fail. Under the Writers menu, set the “Redirect to
Inspection Application” and re-run the workspace. Inspect the results in Data Inspector to ensure

the sworld_geometry{0}.sworld_name is configured correctly.

14) Clean-up

In the next section you’re going to reload the data. In Smallworld Explorer version manager,
select the fme_training alternative, rollback to the begin checkpoint by double clicking on the
check point and selectin Rollback to Checkpoint. Or in Smallworld explorer select all the Oak
Tree Avenue LV records you just inserted and delete them and commit the deletes. This will give

you a fresh start.
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Database Operation

At this point you let FME default to a database insert operation. If we wanted to update the
existing cable features we’'d need to use an update operation. This is what the
fme_db_operation format attribute is for. FME uses the fme_db_operation’ attribute on the
Smallworld writer features to specify the database operation for each feature. The

fme_db_operation attribute can be set to:
INSERT
UPDATE
DELETE

We’re going to discuss the fme_db_operation attribute in more detail in a later section.

In the next steps, you're going to set the value of the known_as attribute to “connector” if it has a
null value in the AutoCAD dataset.

1) Edit Workspace
Continue editing the workspace you’ve been working with.

2) Modify Tester
You do not need to update the named cables such as “Union Lane LV” or “Lower Milton Rd LV”

so you can filter them out. Open the Tester properties and add the test:
known_as Attribute Is Empty String

3) Add Conditional Tests to AttributeCreator
Now add a couple of conditional expressions to the AttributeCreator. The first conditional
expression will set the known_as attribute:

if known as is “attribute is empty sting” then set value to “connector”
and then to set the fme_db_operation attribute:
if status has value “In service”then fme db operation iS UPDATE

else if status has value "proposed” then fme db operation iS INSERT
(Remember that FME is case sensitive for both attribute names and attribute values)

B AttributeCreator Parameters X
Transformer
Transformer Name: |Am'ihuhecreatnr ‘
Ir Advanced: Attribute Value Handling
Attributes To Set
Attribute Name Value ‘
€ sworld_geometry{Dl.swo & Parameter Condition Definition -
4 known_as
“ fme_db_operation Condition Statement
Test Condition OQutput Value
If ‘@Valuelstatus) = In Service k UPDATE
Else If @Value(status) = Proposed Kk INSERT
Else Z' <No Action>
+ — a2 v = =
+ — & - Edit... Duplicate
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The workspace will now look something like:

Tester [Tester]
Test Description: ™

. TEST @Value(status) = Proposed
TEST known_as ATTRIBUTE_IS_EMPTY ™

Condition: OR.
{ electricity_cable: electric_networkProposed [ALTOCAD_OD] ] [ electridty.cable: [SWORLDSWAF] ]
(/.— ¥ .
[—3 N — {c}_’; =
u\: ¥ electr..._cable <Cie—146 %% ¥ electri...y.cableiCH w |
B id [» Passed = id o
knowr_as (b Failed > =+ known_as
length 73 = voliage
status
o <. AttributeCreator Prsiats
LGl E = centreline_hv
¥ centreline_dv
b= centreli...inacive
AttributeCreator [AttributeCreator] ¥ cenreline
sworld_geometry{0}.sworld_name = centreline i—c P —
known_as = 1
If (known_as™ ATTRIBUTE _IS_EMPTY ™) Then “connector™ ¥+ sworld...d_name
Else <Do MNothing> 'ﬁ-m
: dh..

.. fme_db_operation =

If ("@value(status)” = "Proposed”) Then "INSERT™
Else If ("@Value(status)” = "In service™) Then "UPDATE"
Else <Do Mothing=

4) Test the workflow

When making more complicated workflows, it's a very good idea to try and test them before
attempting to load the data into the database. In workbench, on the Writer menu, set Redirect to
Inspection Application.

Then Run the workspace and check the feature counts on the workspace connectors and also
check the results in FME Data Inspector. You should see all the cables with the exception of
those that had a value for “known_as”. All the “known_as” values should be either “connector” or
“Oak Tree Avenue LV”. “In service” cables should have an fme_db_operation = UPDATE. The
“Proposed” cables should have an fme_db_operation = INSERT.

5) Save and Run
In workbench, on the Writer menu, unset Redirect to Inspection Application.

Save the workspace. Run the translation.

Inspect the updated data in the Professional - Smallworld Core GIS application.
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-
@ Professional - Smallworld Core

(= )

File Edit View Trail Tools Window Help

ISearch Text ;”Mdresaes

;Id" & = (3 B [Becic Network - & & ?X‘@’Q o R G [(zelect A v[|

[ -+-aaooor)

1728 v ||Detai

| B [Brtish National Gid _~ | &|

Object Cortrol  Editor |

AR T MR BY

Pakenhamcl | & /& ~ & ~ @‘Speda\s v|

@@ [Hectricty] Cable

ICab\e{ connector ) By IGEngphIE

Field name | value |a=]
& ld [53s238 |
¢ Known As connector
EE Voltage v =
EE Status In service *
Fe Length 1948m *
/" Certreline v
Object View |0vennew |

=

[% - @& & 4 o -

- -.|1-1031 .‘

-

Click to select geometry or drag to pan

‘Cable{ connector ) Centreline Lv

[Centre: 545338728, 260072208 mm

Qo9 4|

You have loaded some cables into the fme_training alternative and updated some of the existing

cables.
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Writing to Smallworld Multiple Geometries

The Smallworld data load in the previous example had only a single geometry on the cable
object.

Many Smallworld objects have multiple geometries which might include one or more feature
geometries (chain, area, point) and an annotation. Annotations often have the same text value as
one of the feature attributes, e.g. “name”.

Example 5: Write Multiple Geometries

Scenario FME user

Data Smallworld supply point object; feature inserts

Overall Goal Attach annotations to existing Smallworld Supply Point objects

Demonstrates How to write text onto Smallworld objects as part of multiple geometries
Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld5-Complete.fmw
Workspace

Load Supply Point Multiple Geometries
In this example you are going to load the Supply Point object which has both a point (location)
and text (label) geometries.

1) Generate Workspace
You're going to generate the workspace in the same way you did in the previous section. Open
FME Workbench. Choose the Generate Workspace option.

Reader Format: Autodesk AutoCAD Map 3D Object Data

Reader Dataset:
C:\FMEData2015\Resources\Smallworld\sourceData\electric_networkProposed.dwg

Reader Parameters

Expand Blocks into Entities  uncheck * [ Prepend Table Name
4 ||| Expand Blocks into Entities “

se Blod

=]

Writer Format: Smallworld 4
Writer Coord Sys: BritishNatGrid_mm
Writer Parameters

Service: FME

Alternative: [fme_training

(Be sure to use the | symbol as the first character)

In the Generate Workspace dialog, place a checkmark on the “Import feature type definitions”
checkbox.
Click OK.
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2) Import Writer Feature Types from Smallworld

&2 Import Witer Festure Types S = The “Import Writer Feature Types” dialog will
Reader appear_
Format:  Smalworid 4 v [ Click on the Parameters button, and select:
ey [P Table List: electricity.supply_point
(Peanetes. B coord. Syten: i " Click OK to close the import feature types dialog.
T | OK | | Cancel |

3) Select AutoCAD Layers

The Select Feature Types dialog will open. This is the AutoCAD layer selection.
Select electricity_supply_poin

And click OK, to generate the workspace.

4) Save Workspace
Save the workspace locally at
<My Documents>\My FME Workspaces\Smallworld5.fmw

5) Connect Reader and Writer Feature Types

Connect the electricity_supply_point reader feature type to the new electricity.supply_point writer
feature type.

Expand the attribute lists for the reader and the writer.

The Smallworld writer exposes the geometry fields on the electricity.supply_point feature type —
location and label.

6) Redirect to Inspection Application

When making more complicated workflows, it's a good idea to try and test them before attempting
to load the data into the database. In workbench, on the Writer menu, set Redirect to
Inspection Application. All your output will be redirected to the Data Inspector as you build your
workspace.

Also, as you build your workspace, add Data Inspector transformers to inspect the intermediate
results.

7) Filter the Proposed Supply Points
You only need to insert the proposed supply points. Add a Tester transformer to filter out the “In
service” cables (or conversely keep the “Proposed” cables).

8) Filter the Point & Text Geometries
Add a GeometryFilter and expose the Point and Text Geometries

9) Set Geometry Name and Database Operation
Add an AttributeCreator transformer to your workspace and connect it to the GeometryFilter
Point port. In the AttributeCreator add the attributes:

fme_db_operation INSERT insert new records only
sworld_name location the Smallworld geometry field name
customer_class New Customer S0 we can recognize the new records

Add a second AttributeCreator transformer and connect it to the GeometryFilter Text port. In the
AttributeCreator add the attributes:
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fme_db_operation INSERT insert new records only

sworld_name label the Smallworld geometry field name
sworld_height 1 some text characteristics
sworld_horiz_just 3

sworld_vert_just 1

sworld_orientation fme_rotation fme_rotation is derived from the DWG
customer_class New Customer S0 you can recognize the new records

You've changed the customer_class attribute value so we can recognize the new records in
Smallworld

& Aggregator Parameters [
10) Combine the Location and Label Tesformer
Geometries - Aggregator rersforme tene: | SFEEN -
The Aggregator transformer produces a new Tt Growpt: ) &
feature geometry structure that is an FME e O 318
aggregate. An aggregate is a feature that Parameters
has multiple geometries sharing the same ——P Hode: [Geometry - Assembie One Level S|
attributes. In this case the aggregate Count Attribute:
consists of a text (for the label) and a point D A
(for the Iocation)_ of the supply point. The ———— Keep Inout Attibutes: [es 1=
aggregator requires a key for the —— B LstName: sworld_peometry =
aggregation (Group By parameter). For Attributes to Concatenate: No tems selecied, mie!
many CAD to GIS problems, there may be R —— =
no key attribute so a NeighborFinder Atrates fo Sun: [NoTomes & E
transformer might be used to make a spatial Ta— &=
join. We’re lucky — this DWG file has an id L e Blo
field we can use.
4 Assemble One Level

Add an Aggregator transformer and iy fogreste Tie: [ctroomens Gleson 218
connect both of the AttributeCreators to the Geometry ame bt &
input port. > Assemble Hierarchy

Help Defaults ~ | cancel |

11) Set Aggregator Parameters

In the parameters dialog for the Aggregator, enter these settings:
Group By: id
Mode: Geometry - Assemble One Level
Attribute Accumulation
Keep Input Attributes Yes
List Name: sworld_geometry
Aggregation Type Heterogeneous Collection

The Aggregator transformer merges your point (location) and text (label) features using the id
attribute as the key. The Mode sets the type of merge used for geometry — in this case a simple
(one level) geometry structure.

List name: sworld_geometry builds a list for each aggregated feature so you'll end up with
something like:

sworld_geometry{0}.sworld_name location
sworld_geometry {1}.sworld_name label
sworld_geometry {1}.sworld_height 1

and so on...

Remember, the sworld_geometry{}.sworld_name links the appropriate part to the FME geometry
to the Smallworld geometry field.
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The Aggregate Type ensures the merged geometries maintain their geometry structure.
Add a Data Inspector to the Aggregator and inspect the results.

12) Clean-up Attributes (Optional)
You can add a couple of BulkAttributeRemover transformers — as shown below — to remove
redundant AutoCAD attributes using regular expressions:

“autocad

“fme attrib info

Your workspace should look something like this:

AttributeCreator [AttributeCreator]
fme_db_operation = INSERT
sworld_name = location

(@) Clean-up Aut...D attributes

(g ¥ electr.._point b—140—{ Bulkatt |
\.:./u electr.._point {50 {é}J
points & text

7 address1 > Output =

Merge location & label

(=) Set Smallworld attributes Create sworld_geometry{} list

| address2 | 1w - . ) attribute
| austomer_dass | = BulkAttr..emover_2 {3 »~ GeometryFilter  {2% 3/—U'k.!\t'l.riI:vuteCreamr 5%
‘ .custorre(_id ‘ (b Output: = \;D Point r—’ [D Output }— 3 Aggregalnr {§}]
‘ id ‘ (b Text — ! [> Aggregate }— 3 =8 welectr.._point {5
‘ IR ‘ s [ b <Unfitered> = = —#tAttributeCreator_2 {é} B id
| sales | Keep Propedl Supply Points b Output P 5 customer_class |
‘ status ‘ - Y = customer
| usege | mlabd

,D Passed AttributeCreator_2 [AttributeCreator] #= location

P> Failed 4 fme_db_operation = INSERT = fme_db._ration

sworld_name = label

sworld_text_string = @value(id)
sworld_height = 1

sworld_horiz_just = 1

sworld_vert_just = 3

sworld_orientation = @Value(fme_rotation)

Tester [Tester]

Test Description: ™
TEST @Value(status) = Proposed
Condition: OR

13) Save and Run
Run the workspace and inspect the results in Data Inspector.

On the Writer menu, unset Redirect to Inspection Application and run again.

Inspect the updated data in the Professional - Smallworld Core GIS application. If you need to,
use the Smallworld Versioning to roll back to the last checkpoint and correct your workspace.

Save the workspace.
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Summary

In this exercise, you’ve read point and text
features from the AutoCAD dataset and
then merged them with the Aggregator
transformer. The Aggregator transformer
also builds the required sworld_geometry{}
list attribute required by the Smallworld

writer.

@ Explorer - Smallworld Core - \My Datasets\Electricity\Electricity Network\Supply Point

=ANCN X

File Edit View Object Help

crEARE G A HRER D

Address |My Datasets \HectricityElectricity Metwork \Supply Point

Folders X |Id Customer Class | Location
=3 Explorer LJJ CAM-55843-5P New customer &
+ /{ Map Selection —q CAM-55844-5P New customer &
=-f@l My Datasets CAM-55845-5P New customer &
+-[3 Gis CAM-303045-5P Private -$—
=1 (3 Electricity CAM-303049-5F Private -$—
Z 6 Blecticity Network CAM-309053-5P Private &
@ Cable CAM-503057-5P Private $
8 Customer CAM-303061-5F Frivate -$—
@ Jairt CAM-303065-5F Private -$—
(31 Substation CAM-909069-SP Private &
(31 Substation Intemals | CAM-909072-5P Private &
() Supply Point CAM-909077-SP Privats &
#F Drawing - | CAM-3D3081-5P Private &
<[ r <[
Supply Pairt Mumber of Records: 76

Label

L

» P

=l @
Customer =
[l

538244
538074 -

Pakenham Cl
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Database Operations on Smallworld

You have used the ‘fme_db_operation’ format attribute in the previous sections. FME uses the
‘fme_db_operation’ attribute on the Smallworld writer to specify the database operation INSERT,
UPDATE, or DELETE for each feature.

When the operation is UPDATE or DELETE, the reader feature must also supply the join key
attribute that matches the Smallworld ‘sys_id’ on the writer feature type. FME will automatically
identify the record to write using this join key attribute. The fme_db_operation can be used to
control incremental updates to the database.

When the operation is INSERT, the join key attribute must not be included on the feature. For
inserted records, Smallworld creates an internal ‘sys_id’ automatically, and the insert operation
will fail if the writer attempts to supply a join key.

Example 6: Database Operations

Scenario FME user

Data Smallworld electricity database; Cambridge_Electricty_Updates dataset
Overall Goal Update the electricity database with object changes

Demonstrates How to write insert, delete, and update Smallworld records

Starting Workspace | Create from scratch

Finished Workspace | "C:\FMEData2015\Workspaces\SmallworldTraining\
Smallworld6-Complete.fmw"

Update Electric Network

New electrical connections were proposed for new customers in the previous sections. These
proposed changes have now be Accepted. Some new connections also require that existing
connections be changed or removed. This example will update the Smallworld database with
these new customers and with the changes to the electrical system.

In this example you’ll use a GML file that has been created by a change management system.
Changes are tracked by the update_type attribute as either D, U, | (delete, update or insert).

1) Inspect Source Dataset

Inspect the source dataset at
C:\FMEData2015\Resources\Smallworld\sourceData\Cambridge_Electricity Updates.gml

Some features have no geometry. All features have an update_type attribute that indicates the

type of database operation to perform: | (Insert), U (Update) & D (Delete).

2) Add Smallworld Alternative
In the Smallworld Version Management application, add this new alternative or version if it
doesn’t already exist:

Dataset Name of Alternative
Electricity fme_updates
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3) Generate Workspace
Start FME Workbench. Choose the option to Generate Workspace.

Reader Format:
Reader Dataset:

GML (Geography Markup Language)
C:\FMEData2015\Resources\Smallworld\sourceData\
Cambridge_Electricity_Updates.gml

(¢ Generate Workspace =
Writer Format: Smallworld 4 Reader
Writer Dataset: localhost:30000 Format: GML (Geography Markup Language) + [
Writer Coord Sys: BritishNatGrid_mm Dataset: sourceData\Cambridge_Hectriity_Updates.gm ] B8]
Writgr Parameters Parameters...] () Coord. System: Rezd from source. + ()
Service: FME
Alternative: [fme_updates e _
(Be sure to include the | symbol as the first character) formatz | Smalloorid 4 -/ =
Dataset: localhost: 30000
Place a checkmark on the Import feature type [Parameters... | Coord. System: Brtshiataid mm, v [
definitions checkbox. 7] tmport feature type definition; < s—
Workfiow Options
Click OK to generate the workspace. 4B Smalworkd 4 Parameters ==X
Database Connection —
Server Host: | BT u

4) Specify Feature Types

When the Import Writer Feature Types dialog

appears, click on the Parameters button.

Set these parameters: ——

Service: FMENOFACTORY _ <

Table List: electricity.cable et e e
electricity.customer [ rep ] [oefmis =] [ o5 ) [ cancel |
electricity.supply point

Server Port: 30000
Service: FME

Username:

When the GML Select Feature Types dialog appears, select these feature types:
electricity cable
electricity customer
electricity supply point.

5) Tidy Workspace

The feature types on the reader may be in a different order than on the writer. To make the
feature type names easily visible, you can select the feature types and resize them, or add an
annotation can be attached to each feature type.

To add an annotations, select all the feature types. Right-click and choose the Attach
Annotation option.

Tidy the workspace so that each reader feature type is horizontally aligned with its matching
writer feature type; but don’t connect them yet.
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[ electricity_customer: Cambridge_Electricity_Updates [GML] ]

— o
‘\;- > eledtr...stomer {0

[ electricity_supply_paint: Cambridge_Electricity_Updates [GML] ]

=

.\ti. b electr.._point {04

[ electricity_cable: Cambridge_Electricity_Updates [GML] ]
‘V

( E.jb electr.._cable 400>

6) Set Database Operation

[ electricity.customer: [SWORLDSWAF] ]
¥
-
b electr...stomer 40 .p,/}

[ electricity.supply_paint: [SWORLDSWAF] ]

L >

i{ » electr.._point -.i )
—

[ electricity.cable: [SWORLDSWAF] ]

¥
—— -
3 e\ectr\...y.cable%jjfl.’/l

Add an AttributeValueMapper transformer connected to a reader feature type. The update_type
attribute identifies which type of operation applies to each feature.

Source Attribute:
New Attribute Name:
Value Mappings

update_type
fme_db_operation

I INSERT
D DELETE
U UPDATE

Use Duplicate transformer and connect the duplicates to the remaining feature types as shown

below:

[ electricity_customer: Cambridge_Electricity_Updates [GML] ]

@ P> electr..stomer {é};b——PEAﬂrihuL..ueMapper {Z:}J

I Output }\
[ electricity_supply_point: Cambridge_Electricity_Updates [GML] ]
@) I electr..._point {§}D—D{Ath‘ihul...mpper_2 {é}]

I Output P

[ electricity_cable: Cambridge_Electricity_Updates [GML] ]

&
@ I electr.._cable {@}D—PEAﬂrihuL..Mapper_a 4es
P> Output F)

AttributeValueMapper_3 [AttributeValueMapper]
Source Attribute: update_type

Destination Attribute: fme_db_operation

Mapping Direction: Forward (Source To Destination)
Mapped Values:

[->INSERT

D-=DELETE

U-=UPDATE

Default Value: <not set>
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7) Set Geometry Name: centerline & location

Add an AttributeCreator transformer to your workspace and for supply_point add the attribute

sworld_geometry{0}.sworld_name location
Add an AttributeCreator transformer to your workspace and for cable add the attribute

sworld_geometry{0}.sworld_name centreline
Remember the role of the r£‘- AttributeCreator Parameters =5
sworld_geometry{}.sworld.name list attribute. It P
associates the correct part of the FME geometry S prew——
aggregate to the correct Smallworld geometry
f|e|d > 7] Multiple Feature Attribute Suppart

) Atiributes To Set
. ribute Name Ir\\: alue

Why don’t you need an AttributeCreator for the zt iv:rmN_geumm{m.swml T gil centreline
customer feature type? —
8) Connect to the Writer Feature Type
Connect the AttributeValueMapper or
AttributeCreator output ports to its associated + -« v == picate
writer feature type.

Your workspace will look something like the one below:

[ electricity_customer: Cambrldge _Electricity_Updates [GML] ]

‘.p I electr...stomer i,\}b-— 4 —W(Al‘lrlhut. ueMapper {é}

[ electridity.customer: [SWORLDSWAF] ]
¥

(poupue b 4

[ electricity, supplyjolnt Cambridge_Electricity_Updates [GML] ]

‘. P> electr..._point 'L}B‘ 7 -hEAtlnhuL Mapper_. Z{O} /—Efmtnhulecreator @J
» Output — boupue "

[ electricity_cable: Cambridge_Electricity_Updates [GML] ]

L T )
(bouput

(b Outuut

9) Inspect Output

Fr—
PP electr..stomer {GH )

[ electridty.supply_point: [SWORLDSWAF] }
4 -
# b electr.._point {5 m |
-

[ electricity.cable: [SWORLDSWAF] ]
4 -
ot > electri...y.cable%j}}:.pijl

Click on Writers > Redirect to Inspection Application to turn on this setting.

Save the workspace. Run the workspace.

Inspect the output in the FME Data Inspector. Use the inspection tool to select cables and supply
points and then verify their attributes. Note that for the INSERT’s the id (or customer_id for
customers) is missing. This is because it's a new feature and does not yet have a ‘sys_id” created

yet.
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% FME Data Inspector = | B |-
File View Camera Tools Settings Window Help
¥ L.} T o L K=t
Bl R cHvElI«@aQ QE @ @Y
Feature Information 2 X viewl x | View 2 | View 3 | View 4 0 ‘ View 5 |
Features Selected: 1 oft 4 »
Property Value =
Feature Type electricity.supply_point
Coordinate System BritishMNatGrid mm
Dimension 20
Number of Vertices 1]
Min Extents nan, nan
Max Extents nan, nan
4 Attributes (17) z
_wh_out_feat_type_ (string) electricity.supply_point BE
customer (encoded: utf-16)
customer_class (encoded: ... Private 3
frne_basename (string) Cambridge_Electricity_Updates
fme_dataset (string) CAFM EData2014\Resources\SmaIIworId@
fme db operation (encode.. DELETE
frne_feature_type (string) electricity_supply_point E]
fme_geometry (string) fme_undefined
fme_type (string) fme_no_geom |4
gml_id (encoded: utf-16) \dlhdchSa?-g(fc-d?ld-aﬁBc-dEﬁQfZSaé{;]
id (encoded: utf-16) CAM-909293-5p
multi_writer_id (string) a
orientation (encoded: utf-16) a:
| aword gcomeirul0lavond,, ocaiion T | 0 ies Cortesy of vapouest
Feature Information Display Control &
Table View 5 X
id custs -_class custs label location sworld_geometry{0}.sworld_name fme_db_operation |~
1 Private 6901536570885.., location IMNSERT
2 <missing=> Private G901536570885... location INSERT =
3 Private 6901536570885.., location INSERT
4 CAM-8909277-5P  Private location DELETE N
5 CAM-809285-5P Private location DELETE
6 CAM-909283-5P Commercial 6001536570885... location UPDATE i

Q

in [any column

| electricity. cable I electridty.customer

1selected [ 7 row(s)

electricity. supply_point |

Table view | Log

SPHERICAL_MERCATOR X 143833169 Y: 6839734.6199

Here’s what’s going to happen:
Feature Type Operation
customer INSERT
cable DELETE
cable INSERT
supply_point DELETE
supply_point INSERT
supply_point UPDATE

10) Write the Output

Total:

Feature Count

4

P W Ww N W

21

In FME Workbench, click on Writers > Redirect to Inspection Application to turn off this

setting.
Run the workspace.

Open the Professional - Smallworld Core application.
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Use the “Electric Network” bookmark to zoom in to see the area of interest around at Oak Tree

Avenue.

Inspect the output in Smallworld. In the Smallworld Version Manager double click fme_updates
to make it the current alternative. You may need to refresh the GIS view.

@ [ |[r000 | [Detai | B2 [Brtish National Grd _~ | B
O CAM
% »
CAM-303253-47
CAM-S03IT3-30 i
N <
Folders X | Customer Id | Name Address1
=3 Explorer » [939217 The Occupier Oak Tree Avenue
= Browse (Editor) 939234 The Occupier Oak Tree Avenue
@ Supply Pairt (Blect 268910374  The Occupier Ramsden Square g
/{ Map Selection 268910376  The Occupier Ramsden Square
=-f3 My Datasets 268910381 The Occupier Ramsden Sguare
+-[3 Gis 268910387  J. Bayswater Ramsden Square
=-[3 Blectricity 268910404  The Occupier Ramsden Square
=5 Blectricity Netw i
[ Cable 65015365... Mark Oak Tree Avenu
[5) Customer 69015365... Don Oak Tree Avenue
@ Joint 69015365... Steve Oak Tree Avenue
[ Substation 63015365...  Safe Software Inc Oak Tree Aven
N
W
&

Locate the inserted cables and supply_points.
Compare the fme_updates alternative to the
base to detect the records that were deleted.

Use the object Explorer to locate the customer
records that were inserted, since without
geometry they won'’t appear in the view.

There is a relationship between the
supply_point’'s and the customer table. This
relationship uses an intermediate join table.

The GE Smallworld writer cannot create joins
through an intermediate join table, so the
supply_points have not been joined to their
customers. You would have to accomplish this
in the Smallworld GIS Object Editor.

FME can be used to import objects that have a
direct join (parent/child) relationships. These
can be a simple 1:0..n simple joins, 1:0..n
heterogeneous joins or 1:0..n multiple joins.

& Smallworld Translators Documentation

S

&= B o«

Hide Locate  Back

Corterts | Search | Favorges |

©Q© @ B [ @

Stop Refresh  Options  Printing Help

(2 Smallworld DXF Translator

€] 1 Abolt this release
@ 2 Qverview

@ 4.3 Logical fields
[£] 4 4 Geometry fields

sl s3] 4.5 Join fields|

1] Appendix
Q Using the Documentation

L] 3 Setting up the Smallword FME Connectio
= @ 4 Translating fields of Smallwodd RWOs
@ 4.1 Overview of Smalworld field types ft
@ 4.2 Alphanumeric fields supported.

Q Installing Smallworld Translators Expand all text
(221 Smallworld Spatial Object Managers

& |} Smalworld FME Translator Reference 4.5 Join fields

} Importing and exporting text join fields

» Importing and exporting foreign key fields

On export. join fields of a Smallworld object provide the values for . ..
user attributes of an FME feature. On import, user attributes of an p|US a I|tt|e more on jOInS Iater
FME feature provide values for the join fields of a Smallworld
object. Only text-based join fields and foreign key fields are

Other join fields of a Smallworld object are not imported or

exported and so this data is not available to the Smallworld FME
[£] 5 Using exdsting FME mapping files Translator.

@ & Troubleshooting import and export operatii
@ 7 Faults Fixed and Limitations

Previous » Next s Top

Frevole sl Top Handling joins is described in the

Smallworld FME Translator
Reference Section 4.5 Join Fields

m

Advanced Task
The supply points that were inserted have no labels.

In the Smallworld Version Management dialog double click on the begin checkpoint to rollback to
the original data.

Database
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Back in FME Workbench, modify the workspace to add label geometry to the supply points. The
changes to your workspace will be similar to the previous section where you added labels to the
supply points.

Run the workspace and in Smallworld check that the re-inserted supply points now have labels.
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Working with Alternatives or Versions

You've already been loading data into different alternatives or versions of the Smallworld
Cambridge database. In the previous exercise you updated the electricity network. The GE
Smallworld reader can read either all the objects from an alternative, or you can configure the
reader to return only the deltas (changes) between alternatives (and checkpoints). This is very
useful if you want to synchronize your Smallworld VMDS with another database, and only export
the incremental changes.

E' Example 7: Exporting Changes Between Baseline and Alternative

Scenario FME user

Data Smallworld electricity database updated with changes from Example 6

Overall Goal Detect changes made to a Smallworld alternative

Demonstrates Configuring FME to export just the differences between a base and alternative

Starting Workspace | Create from scratch

Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld7-Complete.fmw
Workspace

This example requires that the updates from Example 6 have been loaded into
Smallworld. If that didn’t work, you can use the [FME alternative that was pre-
configured with the changes

Extract Deltas from an Alternative

After the electrical network updates have been made to a Smallworld alternative, you can
examine just the differences (deltas) between the baseline and the alternative. This example will
export those differences for inspection.

1) Add Smallworld Reader
Open FME Workbench. Start with a Blank workspace.

Add this reader:

Reader Format: Smallworld 4

Reader Dataset: localhost:30000

Reader Coord Sys: BritishNatGrid_mm

Reader Parameters

Service: FMENOFACTORY

Table List: electricity.cable
electricity.customer
electricity.supply_point
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2) Connect Inspectors
Connect an Inspector transformer to each reader feature type.

—

( @)bebectr...stomer{ng}h—k{electri...uﬁomr%{}f@ 3) Run and Inspect
= _ . Run the workspace. You'll see all the objects from
:-\E*)'e“-‘d"---ﬁ’-ca""‘-‘i‘v‘}b—“f" eleciricity.cable 4} % the ‘top’ alternative. You won't see any of the

= _ —,  changes you made to the database in the previous
I_\@)b electr..._point il\g}i—li{electri...y_point %Ef%lc}) exercise.

y

4) Select an Alternative
In the workspace Navigator, under the Smallworld reader, select Alternative and set the reader
alternative:

Alternative: [fme_updates

5) Run and Inspect
Run the workspace. You'll see all the objects from the ‘fme_updates’ alternative. You should see
the changes you made to the database in the previous exercise.

6) Export Changes
Back in the workspace Navigator, under the Smallworld reader, select set the following reader
parameters:

Export Changes from Baseline Yes

Baseline Alternative: | (pipe character represents the ‘top’)
or use:

Export Changes from Baseline Yes

Baseline Alternative: |[fme_updates

Baseline Checkpoint begin

You can restrict the export of changes to a specific checkpoint on the baseline
alternative.

7) Run and Inspect
Run the workspace. You’ll see only the deltas between the ‘top’ alternative and the ‘fme_updates’
alternative.

Note: that the Smallworld reader automatically adds and sets the fme_db_operation attribute
when you export changes so you could use these features to update other databases that FME
supports.

8) Save Workspace
Save the workspace locally at
<My Documents>\My FME Workspaces\Smallworld7.fmw
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5 FME Data Inspector | 5 e

File View Camera Tools Settings Window Help

Feature Information 8% x| view7 x| views x | views x [ vewin x | viewit | 4
Features Selected: 1 0ft 4 . -
] /5
Property Value i

Feature Type electricity.supply_point

Coordinate Systern BritishMatGrid mm

Dimension 20

Mumber of Vertices 2

Min Extents 545867317.0, 2600753470

Max Extents 545886952.0, 2600758070 |

4 Attributes (20) g

customer (encoded: utf-16) : =
customer_class (encoded: ... Commercial
fme_basename (string) localhost:30000
fme_dataset (string) localhost:30000 4
fme_db_operation (encode.. UPDATE 4,
fme_feature_type (string) electricity.supply_point [w) v S
fme_geometry (string) fme_aggregate %
fme_type (string) fme_collection &
id (encoded: utf-16) CAM-909283-5P

sworld_geometry{0}sworld... 2
sworld_geometry{0}.sworld... label
sworld_geometry{0}sworld... 0.0
sworld_geometry{0}.sworld... 1.0

sworld_geometry{0}.sworld... CAM-909283-5P -
Tiles Courtesy of M
Feature Information Display Control
Table View =2
id [ _class « fme_db_operation label location g

2 CAM-55871-SP  Private INSERT

3 CAM-55872-5P  Private INSERT

4 CAM-909277-S5P  Private DELETE =
5 CAM-903285-5P Private DELETE

6] < missing> <missing>

7 CAM-909293-5P Private DELETE -
Q in [any column A 1zelected [ 7 row(s)

[ electricity.cable | electricity.customer | electricity.supply_point. |

Table View Log

SPHERICAL_MERCATOR  X: 148853698 Y. 68398941506

Exporting incremental changes in this way can be used to synchronize a Smallworld VMDS with
an Oracle or an SQL Server geodatabase.

Advanced Task—WHERE Predicate

The Smallworld reader supports WHERE predicates that can be used to select a subset of data.

In the Workbench Navigator pane, locate the parameters for the Smallworld reader.
Set these parameters to select only cables whose status is "Proposed":

WHERE Clause: [Electricity] cable where Status = "Accepted"
Export Changes from Baseline: No

Run the workspace. Inspect the output. Only the ‘Accepted’ cables are exported.
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Join Fields

FME can read different types of join fields. FME can also read intermediate join tables, for
example electricity.int!lsupply_point_customer. So when exporting from Smallworld you can
reconstruct more complex joins.

To export join fields, you may have to make the fields visible in the Administration ACE
application. Some fields are not always made visible in the Smallworld GIS, and they must be
visible for FME to be able to access the fields.

The GE Smallworld writer can import join fields for text based joins fields and foreign key fields.
Other types of join fields are not supported, Refer to the GE Smallworld documentation:
Smallworld FME Translator Reference — section 4.5 Join Fields. You may have to make some
fields visible using the Administration ACE application

FME can load simple joins. There are three types of joins that can be represented:
e Simple parent — child 1:0..n relationship, i.e. Town - Roundabout
¢ Heterogeneous relationships. These are parent — child 1:0..n relationships, where there
can be different parent objects. i.e. Office or Point of Interest may join to a Road Works

o (Iz/lbdﬁticgle child object joins. These parent — child relationships have one parent but multiple
child objects.
Example 8: Viewing Intermediate Join Tables
Scenario FME user
Data Smallworld GIS Electricity database
Overall Goal Export data with an intermediate join table
Demonstrates Configuring FME to export more complex joins
Starting Workspace | Data Inspector only

Viewing Intermediate Join Tables
You'll use FME Data Inspector to view more complex join tables. Let’s look at the following tables
and their related join tables:
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Electricity Network

hhhhhh
s,
_____
e,

Wesble ppplypoint el

AT,

Supply Point

oo

O

Customer
The image above comes from the Smallworld CASE for the Electricity Network. There is a join
table for Customer and Supply Point.

1) FME Data Inspector
Start FME Data

Select File > Open Dataset. & Select Dataset To View ==
Reader
Enter the reader format parameters . p—— =i
Reader Format: Smallworld 4
Dataset: localhost:30000
Coord. System:  BritishNatGrid_mm - E]
Enter the Coord. System: Select BritishNatGrid_mm

2) Enter Database Connection Parameters

Click on the Parameters button and enter the [ Smallworld 4 Parameters (|
Smallworld database connection parameters: S
Server Host: localhost Server Host:  localhost
Server Port: 30000 Server Port: | 30000
aervice: |(:b|\|/|Ek) Service: FMENOFACTORY
sername: an Username:
Password: (blank) Pasoward [Enter a password
3) Select Constraints =
Still in the Parameters dialog, check Expose Internal [oinrvic 1 | e
TabIeS. Table List: .substation electricity.supply_point E]
Alternative:
Checkpoint:
WHERE Clause: (]
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Click on the browse button next to Table List.

In the Filter text box, enter “electric” or “gis” to filter the list of feature types.
Select each of these feature types:

[ Select Feature Types li:hl

V| electricity.cable - ® eIeCtrICItycable

J| electricity.int!supply_point_customer o electr|C|ty]0|nt

7 ot eobtation . electricity.substation

7] electricitysupply_peint ) electricity.supply_point

7] gis.min_road L — .
demographicsarea . electricity.int'supply_point_customer
demographics.construction 3

Q| Selectall [7] Sorted The int! objects are the intermediate join tables.

==

Click OK to close the Select Feature Types dialog.
Uncheck Use Search Envelope.
4) Inspect Results
In the Data Inspector Table View you should see all of the selected objects. The

electricity.int!supply_point_customer is the join table for Customers & Supply Points.

You can use the same steps in Workbench to create a workspace that reads and preserves the
relationships between the Customer and Supply Point objects through the int! tables.
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Example 9: Importing with a Simple Join

Scenario FME user

Data Smallworld GIS database updated with changes from MIF Data
Overall Goal Import a data with a simple join

Demonstrates Configuring FME to import a child object and update the parent

Starting Workspace | Create from scratch

Finished C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld9a-Complete.fmw
Workspace

Simple Joins
In this example you’ll load some new features for Company and Office. This is a 1:n relationship
with Company as the parent and Office as the child table.

As mentioned above, to export join fields, you may have to make the fields visible in the
Administration ACE application. In the following example, the Company object has had the ‘id’
field made visible and the Office object has had the office_id and company_id made visible.
These fields are not exposed in the default Cambridge database.

To do this in Smallworld: you would use the Administration application to open the ‘ACE
Configuration’ tool. Use the Edit — Object Properties menu to change the appropriate properties,
including the field visibility.

First we’ll add a new Company record to the Smallworld database:

1) Open Workspace
Start FME Workbench and open the workspace:
C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld9a-Complete.fmw

2) Run Workspace
Run the workspace. It will add a new record into the Company onject in the |fme_offices
alternative.

There is no geometry on the Company object so check the results in the Smallworld Explorer
(Tools menu -> Explorer...). Navigate to Gis > Non Topological Objects > Company and browse
all features — don’t forget to switch to the GIS version |[fme_offices

3) Open Workspace

Open the second workspace for this exercise:
C:\FMEData2015\Workspaces\SmallworldTraining\Smallworld9b-Complete.fmw

This is a little more interesting. This workspace adds a new Office record and makes the join to the

Company object.
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[ FeatureReader FeatureMerger
Read Company back from Smalworld ,
pany Merge Parent & Chid to get ID's
6)57&"07 & (ED FeatureReader @}] FeatureMerger {ob AttributeCreator_4 [AttributeCreator]
P Created [ Initiator ] - o fime_db_operation = INSERT
z "-PE Requestor company_id = @value(id)
I gis.company Wosppler ) ;
P <Other> s (b Merged - {Amihmec:mmrj ) =
» Initiator ' [ Notlerged & (> output b———s{vgisoffice  Si{wy |
b Referenced > B office_id ‘\'—/
(b Unreferenced &> 5 name \
¥ DuplicteSupplier> # address] |
 address2 |
[@)Build Smallworld multiple geometry B company |
m # ompany_id |
{ Merge location & label satus ‘
Create sworld_geometry{} list -
(E;)voffme £ii———+ GeometryFilter <35 AttributeCreator 53| | atvibute b seats \

— _name (> Point: (b cutput v B fme_db._ration |
address1 P Tot ::\f::t‘mn }
ke b <Unfitered> > AttributeCreator_3 <5
company
status ROt 7

A

AttributeCreator_3 [AttributeCreator]
sworld_name = annotation
sworld_text_string = @Value (name)
sworld_height = 1

sworld_horiz_just = 1

sworld_vert Just = 3

sworld_orientation = @¥aiue(fme_rotation)

To make the join between the Office and the Company, you have to add the company primary key
to the Office object — as the foreign key. The foreign key on the Office table is ‘company_id’ which
must match the primary key on the Company table which is ‘id’.

In the workspace:

The transformers in the Bookmark “Build Smallworld multiple geometry” creates the Office
feature with location and annotation geometries, in the same way as the previous exercises.

FeatureReader: This
workspace uses the
FeatureReader to
read back the
Company records (we
could have used a
Smallworld reader).
You could also add a
predicate to the
FeatureReader to limit
which Company
records are read
back.

Build Smallworld multiple geo metry

o name

address1
address2
company
status

—i{ GeometryFilter 45| AttributeCreator {57
P Point (b Output

I Text

P <Unfitersd> b AttributeCreator_3 <3¢

B Output

Merge location & label
Create sworld_geometry{} list
atiribute

aggregator 1
I Aggregate

AttributeCreatar _3 [AttributeCreator]
sworld_name = annotation
sworld_text_string = @Value(name)
sworld_height = 1

sworld_hariz_just = 1
sworld_vert_just = 3

sworld_orientation = @Value(fme_rotation)

FeatureMerger: Join the Office object to the related Company. We can make the join using the
company name. The office object now has the Company ‘id’ which can be used as the foreign

key.

AttributeCreator: Rename the ‘id’ field (which is the Company primary key) to ‘company_id’
which is the foreign key on the Office child object.

3) Run Workspace

Run the workspace. It will add a new record into the Office table in the |fme_offices alternative

Check the results in the Smallworld Explorer — don’t forget to switch to the GIS version

[fme_offices.
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[#] Explorer - Smallworld Core - \My Datasets\Gis\Road Network\Office = B e
File Edit View Object Help
-+ @Ba[E X & 25 mE ]
Address [\My Datasets'Gis\Road Network\Office j ﬂ
Folders X | Name Address 1 Address 2 Location | Annotation | Parert Company Drawings |Status | Seats | company_id| office_id
=/ Rload Network . Smalword Systems  61-69 Newmarket Rd  Cambridge CB3 8EG & A GE Smalworld 0] Fomer (1) 850212 8947
(31 Car Pk GE Smallworid 1 High Street Cambridge CB4 1TWR & A GE Smalworld Curent (1) 850212 8950
5 Footpath Guidhal Market Hil Cambridge & A Cambridge Gty Counci Current 901742 21890
Hotel Tourist Information Wheeler Street Cambridge -$- Cambridge City Council Cument 901742 21336
B Motorway Shire Hall Castle Street Cambridge & A Cambridgeshire Court.. Curent 91743 22083
Office Parkside Police St Parkside Cambridge & Cambridgeshire Court Current 901743 22216
'Em Parkside Fire St. Parkside Cambridge S Cambridgestire Court... Curent 901743 22226
& Road Anrotation Safe Cambridge Oak Tree Av Cambridge UK & A Safe Software Inc Proposed 1314009 1314020

F3A Renineshent

Number of Records: 8

For the Company table, you should see the original Safe Software Inc company, but it should now

show the number of related offices:

@ Explorer - Smallworld Core - \My Datasets\Gis\Non Tepological Objects\Company

-

=aacn X

File Edit View Object Help

crARRXFL N E MEER D

Address |\I'l"h.r DatasetsGis\Mon Topological Objects\Company

CEOD

Mr Warmen Ferguson
Unknown

Unknown

Don Murray

Offices
@
@
@
(1)

=l el
Plc? | Type of Busines:
yes (GIS Systems

no  Local Authority
no  Local Authority
no  Spatial ETL

Company

Folders X | Company Name
+Z5 Rail Network » | GE Smallworld
+ 5 Cadastral Coverages Cambridge City Council
+ @ Catalogues Cambridgeshire Courty Counci
= @ Non Topological Objer | Safe Software Inc
CE VIEW
Ej Construction
[71 Seat
.G Nraftinn 5
J b 4

Number of Records: 4

As mentioned before, you may have to use the Administration ACE tool to make some of the join

fields visible.

In summary, to build a simple join relationship you need to set the foreign key on the child table to
match the primary key of the parent table.

Network Topology

FME can export network topology, but to do this you need to expose the network topology fields
in the Smallworld database. This requires some magik code installed into your Smallworld image.
But once configured, FME would expose the internal topology ids for any objects on the

Smallworld network.

Network Topology

Page 55



Smallworld 4.3 Training Pathway

SAFE SOFTWARE

Session Review

Ll e o This module demonstrates how to use Spatial ETL to

transform Smallworld data for use with other spatial formats

What You Should Have Learned from this Session
The following are key points to be learned from this session:

Theory

Connecting to a Smallworld database requires the Smallworld 4 Suite - FME and the
Smallworld FME Translator to be installed and operational.

FME can represent Smallworld objects in two ways, in simplified form using FME Service,
and in a “raw” form with the FMENOFACTORY Service.

FME can read and write Smallworld multiple geometries, using the ‘sworld_geometry’
list attribute

When importing data to Smallworld, it is essential to inspect the source and destination
schemas to ensure an accurate translation. The Smallworld CASE report is useful to
show the Smallworld object schema

FME can export just the differences between a baseline and alternative.

FME Skills

The ability to use FME Data Inspector to inspect Smallworld data
The ability to transform Smallworld data into various other formats

The ability to use FME transformers to restructure data between Smallworld and other
formats

The ability to use the FME and FMENOFACTORY Services

The ability to read and write single and multiple geometries

The ability to specify a database operation for each feature when writing to Smallworld
The ability to extract just the differences between a baseline and alternative.

Working with simple joins and reading intermediate join tables.
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